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In 2004, I responded to the mounting pressure from clients to do something that I had been 
resisting: I developed a workshop that was specific to a particular software product. I focus on 
teaching simple data visualization concepts—principles and practices—that can be applied to 
any software. I don’t enjoy teaching workshops that involve such uninspiring instructions as 
“To create a chart, select Insert from the menu, then select Chart, which will cause the Chart 
Wizard to appear.” Prompted by a desperate request from Purdue University, however, I 
developed a half-day workshop designed to help businesspeople apply these principles and 
practices to Microsoft Excel. I gave this new workshop the title “Excel Charting: An Extreme 
Makeover.” Mostly, it involved teaching people which of the many available chart types were 
actually useful, how to reformat them to eliminate senseless visual clutter, and how to save 
the results in a “User-Defined” library of charts so they could get to them fairly easily and 
ignore the stuff that doesn’t work. 

When I heard about a year ago that Microsoft was in the process of creating a brand new 
charting engine for Excel, I let out a shout of joy, recognizing a tremendous opportunity to 
improve the visual communication of quantitative data for millions of people. More charts are 
probably created with Excel than with all other products combined. Improving Excel’s charting 
functionality could be a great leap forward for humankind. All right, I know this isn’t in the 
same league as solving world hunger, but for someone like me who works hard everyday to 
improve the effectiveness of data communication for businesspeople, this is a big deal. 

With the assistance of a colleague at the University of California, Berkeley, I learned who at 
Microsoft was responsible for the development of the new charting engine and quickly sent 
him an e-mail. In it, I introduced myself and offered to send him my suggestions for shaping 
Excel’s new charting functionality. With his polite assent, I submitted a list of 
recommendations. In response, I received a very courteous e-mail. Here’s an excerpt: 

Thanks. This was quite interesting and useful. I think you’ll be pretty happy with 
some of the changes we are making for Office 12…I did read your book for 
inspiration (as well as Tufte, Cleveland, Wilkinson, Zelazny, etc).  

I realized that he couldn’t commit himself to specific changes to Excel and that his good 
intentions would probably be forced to compete with various interests and powerbrokers 
within Microsoft, but I held out hope that some positive changes would be forthcoming. I kept 
my fingers crossed for months, having no way to know what was coming. 

Having no relationship with Microsoft that grants me access to the beta version of Excel 
2007, I’ve had to be patient, satisfying my curiosity with the crumbs of information that have 
sifted out through official channels. I have now seen enough, however, mostly through the 
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official Microsoft Office 2007 preview blog, to be reduced to near clinical depression were it 
not for the wonders of modern drugs. What follows is my sad account of travail. Briefly put, 
lovers of superficial decoration with no regard for the data can breathe a sigh of relief, for 
chartjunk will continue to rule the day. 

Fluff, Fluff, and More Fluff 
 
Here’s a recent entry in the blog dedicated to previewing the next release of Excel: 

Wednesday, April 12, 2006 5:44 a.m. by Helen 
 
Looking at what users do is not necessarily the best way to think about what 
should be done... Just because everybody does it, doesn't mean it's good.  
 
Please, consider talking to experts instead of polling the public (which is what 
you've effectively done… 
 
The average user is far too easily charmed by visual effects that are actually 
misleading and detract from the quality of the chart. 3-D charts are a good 
example—and the cone charts in Excel are an absolute abomination, because 
they distort data. Likewise the average user is likely to add noise to their charts 
in the shape of gridlines, borders, patterned lines, shadows, etc.  
 
Excel should guide its users towards good design, not towards common design 
mistakes.  

My sentiments exactly. When I read this, I wanted to give Helen a hug. Software vendors 
should rely on their customers to tell them what they need to accomplish, not to tell them how 
the software should be designed to meet those needs. Most customers are far too 
susceptible to superficial flash and dazzle. If you are a prominent software vendor, such as 
Microsoft, and you provide senseless and data-subverting fluff, customers will use it. This is 
especially true of Excel, one of the most pervasive software products in existence today and 
for most of the PC’s history. Excel users will waste countless hours finding the prettiest 
nonsense to throw onto their charts, rather than focusing on what they need to say and 
finding the best way to clearly and accurately say it. 

Excel is the one product that could stand up to superficial and uninformed customer demands 
by giving them what they need and what really works. Excel has no credible competition in 
the spreadsheet market, so customers would continue to use it regardless and would in no 
time embrace the value of well-designed, spot-on functionality. Most software vendors feel 
trapped by customer demands and are cowed into submission, even when they know how 
silly there are. Microsoft has the opportunity to make a stand for excellence, but either lacks 
the courage, doesn’t understand what works themselves, or doesn’t care. Regardless of the 
reason, it’s the customers who will suffer. 
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The pie chart in Figure 1 provides a good example of how the Microsoft development team 
spent its time. Have you ever seen a more delicious looking pie? 

 

Figure 1: A pie chart good enough to eat, but so what? 

Making a chart three-dimensional and tilting it not only adds no value, but actually takes away 
value by making it harder to read. This graph’s sole purpose is to communicate the 
relationship of five geographical regions to one another and to the whole, but this information 
is poorly served by a pie chart and especially by one that is rendered in 3D. The lighting 
effects that appear as gleam, reflection, and shadow, add photo-realistic physicality to the 
pie, but in so doing distract from the actual message. The information this chart was created 
to communicate is not three-dimensional, and it certainly doesn’t exist as an object in the real 
world upon which the sun shines resulting in shadows. Visual effects such as these are not 
benign—they distract and suggest to users that what really matters is not the meaning of the 
information but how cleverly they can dress it up. 
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Figure 2 reveals what a bar chart can look like with a layer of gaudy makeup: 

 

Figure 2: When light reflects on shiny objects in the real world, we find it annoying, 
but evidently in bar charts this is a useful feature. 

The only question you should ask when looking at a bar chart is: Does it communicate the 
data in the clearest and most accurate way possible? Unfortunately, several aspects of this 
chart’s visual design undermine the simple message in the data. 

Not only is chartjunk the order of the day, but Excel will now offer it in infinite variety. Want to 
create a column (vertical bar) chart? What kind of bars would you like? You can have plain 
old 2-D bars if you insist (but please dress them up with lighting effects, color gradients, 
and…you know the story), 3-D bars, cylinders, cones, or pyramids (see Figure 3). Why stick 
with simple rectangular bars with consistent size and shape from bottom to top when you can 
obscure the data by tapering, rounding, or adding meaningless depth to them? 
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Figure 3: The new version of Excel will make it even simpler to select silly 
variations of tried and true graphs that undermine their ability to communicate. 

So, you insist on sticking with the old classic look, do you? Well, that’s all right, there’s still 
much that you can do to adorn it with cheap costume jewelry. How about one of these (see 
Figure 4)? Go ahead and have some fun with it. It may be paste, but no one’s going to look 
closely enough to notice. That’s the problem, isn’t it? Senselessly adorned graphs don’t get 
examined closely.  

In an official blog entry that proudly describes the superiority of the new charts, a Freudian 
slip of the fingers crept into the claim that it “draws smooth antialiased lies, which makes line 
charts look so much better.” [Emphasis mine.] With this much emphasis on meaningless 
visual effects, people are encouraged treat the data as superficially as it is displayed. That’s 
one way to keep people from looking too closely at your work or the numbers. What a shame! 
Those numbers just might be important. 
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Figure 4: A new Design tab now gives you easy access to a variety of pre-designed visual 
styles, each one equally awful. 

Is this what businesses, which claim to base their decisions on information, have come to? 
Have we entirely lost track of a graph’s objective, which is to visually represent quantitative 
data in a way that brings to light meaningful patterns that could not easily be seen in a table 
of numbers? 

Choices, Choices, and More Choices 
 
Getting back to the official blog once again, the benefit of choices, choices, and more choices 
is explained: “The overall goal is to provide a wide gamut of designs, so that users can create 
very simple or very showy charts quickly and without a lot of fiddling.” And immediately 
following this statement, the writer admits that, unlike the new styles for cells and tables, 
“Users cannot create their own chart styles…, they will be limited to the several hundred that 
ship in the box.” Thank god, what would I do with my time if I didn’t have several hundred 
charting styles from which to choose?  

This is definitely one of those situations in which less is more. Rather than giving users the 
ability to choose from hundreds of styles, most of which don’t work, how about simplifying 
matters by only giving them the best styles, the ones that actually communicate effectively? 
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Several times in the blog, a great deal of emphasis is placed on the conscientious effort of 
the development team to make it easier for users, with fewer steps, to create effective charts. 
I see signs of this attempt and believe that the team’s effort was sincere. I also believe that 
they missed the mark.  

I’ll let the official blog explain what they’ve done to make things simpler: 

In current versions of Excel, when a user creates a chart, the first thing they 
need to do is select the type of chart—column, line, scatter, pie, surface, and 
etc. In Excel 2007, we’ve made the variety of chart types available a lot more 
visible, and we have offered help for users to choose between them.  To insert 
a chart, a user would start with the Insert tab.  Excel 2007 has an insert chart 
type “group” (7 related controls) on the ribbon’s insert tab. This makes it easy to 
pick a chart type, with large icons and tooltips that describe when to use a 
particular type. 

 

Figure 5: It will now be easier to select the most common types of charts. 

So far, so good, except that as you can see in Figure 5, once you select a basic chart type 
from the ribbon, such as Column, you then choose a specific version from a lengthy list of 
variations. In Figure 5, you see only the top portion of a list that begins with 2-D Column and 
3-D Column and continues with four choices in each of three categories: Cylinder, Cone, and 
Pyramid. It continues downhill from here. 

Once a user has chosen a chart type, there are a variety of charting features 
that can help the user communicate their data effectively.  In previous versions 
of Excel, these are scattered around through a variety of dialog boxes, making it 
hard for all but the most diligent users to take advantage of the settings.  For 
Office 2007, we studied a massive number of charts that we found in 
publications, books, and Excel spreadsheets to determine the most common 
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combinations of chart elements such as titles, legend, data table, etc.  From 
this, we created a gallery of predefined chart layouts (e.g., combinations of 
chart elements) that can be applied with one click. 

Figure 6 gives us a preview of some of these predefined chart layouts. This set is for 
scatterplots. 

 

Figure 6: Sample of the predefined “quick layouts.” 

I believe that this is not the way to simplify the creation of charts. Rather than directing users 
to wade through long lists of predefined combinations of components, each with only a 
slightly different layout, it would be better to start users out with a good default layout and 
then make it simple to add and manipulate the components as needed—if needed. The 
purpose of a good set of defaults is to eliminate the need for further manipulation of the 
elements, except in unusual situations. Microsoft’s approach is similar to the way that 
Business Objects forced users to select charts in their original dashboard product, which 
provided an extensive list of “analytics” (tables and graphs designed for very specific 
purposes), which were all just slight variations on a few common themes. You could spend 
hours getting familiar with the extensive variety of combinations, each slightly unique in a way 
that often took a while to notice. 

Once you’ve chosen a chart in Excel 2007, you will be able to modify it in various ways, 
accessed through three new tabs labeled Design, Layout, and Format. When I first read 
about this, I had no idea how these tabs differed in functionality, because we tend to use the 
terms design, layout, and format as synonyms. Expecting that a little reading would clear this 
up, here’s how the explanation of the design tab begins: 

The Design tab allows users to set the style and layout of a chart.  In addition, 
this is where you change the chart type, change the data source, move the 
chart, and a few other things. [Emphasis mine.] 
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By this point in my reading, I was thoroughly confused. If you use the Design tab to set the 
layout of the chart, do you use the Layout tab to set the design of the chart? In the current 
version of Excel, if you want to change the chart type, you right click on the chart and select 
Chart Type from the popup menu, or if you want to change the source data you select Source 
Data from the popup menu. Is it really easier and more intuitive to make these changes by 
selecting the Design tab? I would have a good laugh at this if it weren’t describing the next 
release of Excel. Because Excel is used by millions of people throughout the world, this 
confusing and inefficient user interface, which directs users to slog through a swamp of 
needless choices, will result in an incalculable number of wasted hours and, unfortunately, in 
frequently ineffective and often misleading charts. What a waste! 

Epilogue 
 
So far, I’ve only seen a tiny bit of Excel 2007 and have narrowed my focus in this review to 
those aspects that most offend my sensibilities as someone who cares a great deal about the 
effectiveness of data visualization. We know so much about how to visually communicate 
quantitative information that it is a travesty to address the need this poorly. If all I cared about 
was lining my pockets with consulting dollars, I would welcome Excel 2007 as a blessing, 
because it feeds the need for people like me who specialize in data visualization.  

The truth is, I really care about the quality of data communication. Businesses must 
understand their data to make intelligent decisions. The next version of Excel will do its part 
to keep businesses in the dark. But we’ll just keep right on buying it, won’t we?  

Short of fomenting a revolt, which is not my intention, I would like to incite you who share my 
views on the matter to raise your voices, not so much in protest, but to encourage Microsoft 
to do the right thing by trimming the fluff from Excel and focusing on simple functionality that 
really works. Give Microsoft your permission, as a powerful constituency of conscientious 
businesspeople, to rally the courage to take a stand for what works. Take a look for yourself 
at the blog that previews Excel 2007, consider it thoughtfully, and then express your concerns 
and suggestions. Repurpose the blog to serve not only as a tool of marketing but as an agent 
for meaningful change. If enough of us do this, perhaps we can promote something good for 
the world by pointing this powerful and ubiquitous tool in the right direction and, in so doing, 
help it live up to its name: Excel. 

__________________________________________________________________________ 
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